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Spam of the emall variety is easy to spot. It'sa
message (sometimes two or three!) from someone
you've never heard of, advertising something that
you'd never use or touting some opinion that you
would rather do without, and, while it appearsin
your inbox, it isn't actually addressed to you.

And we all also agree on what we want done about
spam — we want to get rid of it and never get any
more. The first step is hitting the delete button. But
would you like to do something more active? Don't
send a flaming reply; that won't accomplish
anything, except to confirm that your email address
isagood one. What's the right way? Read on for
instructions on how to complain about spam and
for hints on how to avoid it.

The Origins of Spam

The term spam was originally used in Usenet
newsgroups to describe identical commercia or
off-topic posts made to multiple newsgroups. It has
since been expanded to include ordinary email
messages, both UCE (unsolicited commercial
email) and UBE (unsolicited bulk email). (If it's on
the Internet, it must have an acronym!)

The use of the name of a canned lunch meat for these
postings and messages was inspired by a Monty
Python skit in which a group of Vikings sing,
“SPAM, SPAM, SPAM, ...” in the background,
eventually drowning out all other conversation. Spam
certainly is doing that, particularly on Usenet, even
though most news servers, including ours, run
programs that that identify many incoming spam
posts and drop them without distributing them.

The Internet wasn’t born with spam. In fact, spam
on the Internet has a birthday, and | remember it —
| saw several copies of the first widely known
spam message. It was sent in 1994 by alaw firm
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advertising their services for obtaining green cards
through the U.S. Immigration and Nationalization
Service's Diversity Visalottery. Posting the ad to
6,000 Usenet news groups took them less than 90
minutes. Thousands of people sent flaming email
responses back to the firm, which had used its own
email address in the posting. The replies swamped
the firm’'s ISP, which responded fairly quickly by
terminating their account. (There's a copy on the
Urban Legends Web site: http://www.ur banlegend
s.com/legal/green_card_spam.html)

The lawyers behind the Green Card Spam,
Laurence Canter and Martha Siegel, went on to
further spam glory, including writing a book about
spam, How To Make A Fortune On The Information
Superhighway. The book’s title explains why spam
is still flourishing — it works. Not well, but at the
price — virtually free — spammers don't need
much of aresponse rate to turn a profit.

Why Email Spam is Bad

Face it; there's always been spam — door-to-door
saespeople, junk snail mail, telemarketing. What
makes email spam worse than other forms of spam?
Annoying as the others are, they have a built-in
control that keeps them from being too destructive —
they cost the spammer either money or time or both.

There are no such controls on email spam. Sending
email spam isvirtually free for the spammer. There
are software tools that can send millions of copies
of a message out in a matter of minutes and there
are lots of enterprising people who are anxious to
sell spammers the millions of email addresses
they’ll need to do it. No self-respecting spammer
uses their own ISP’s outgoing mail services
anymore; that might cost them their account. But
they don’t need to. There are always thousands of
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other machines on the Internet running poorly
configured SMTP services that spammers can use.

Email spam does, of course, cost. When we receive
spam, we pay for it in time, aggravation, and perhaps
charges for connect time. Businesses pay for it in the
time lost as their employees sift through spam to get
to their real emall, in their network administrators
time, in congestion on their local networks, and in
connection charges. And we al pay for the congestion
that spam causes on the Internet as awhole.

How to Complain

The simplest thing you can do with spamisto
delete it as soon as you receive it. But if you feel
that you must do something more, and some people
who worry about spam think you should, here's
how to complain.

Don’'t complain about spam by replying to the spam
message or by trying to send email to an email
address given in the body of the spam and asking to
be removed from the mailing list.

That worked in 1994, but spammers are much too
sophisticated now for replies to affect them at all.
And the From: addresses in spam messages are
usually faked anyway.

What you should do instead is complain to the ISPs
that the spammer used. While there are exceptions,
ISPs are generally very interested in keeping their
systems free from spam, both because it gives them
a bad name and because it takes resources from
paying customers.

Step 1: Find the machines the spam
traveled through.

Unfortunately, figuring out where a spam message
really came from isn't as easy as you might hope.
You have to look at the message’s extended headers
— the header fields that most email programs don’t
display unless you tell them to. “Reading Email
Headers" on page 4 explains how to display and
interpret extended email headers, in particular, the
Received: headers that you'll read to follow the
trail that the spam message took.

(Probably took, that is. Each legit mail server the
message passes through will add its own Received:
header, but it's quite possible for spammers to add
faked Received: headers when they send their
spam. So the machine that that appears to be the
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originating server may not have anything to do with
the spam at all.)

Asan example, let’s consider the spam message in
figure 3, page 5. It's areal spam message, but the
domain names and IP addresses in it have been
atered. It:

Originated at a dialin connection, perhapsin
Atlanta, belonging to bigisp.net, line ©.

Went through a server in Spain, qrd32565.qrd.es,
ak.a. spanishisp.com, lines ® and @.

And the From: address is on a server in the United
Kingdom, englishisp.com, line ®.

Step 2: Check the body of the note for
email addresses or Web sites.

If there are email addresses or Web sites in the body
of the spam message, add their “upstream
providers’ to your list of addresses to complain to.
Unlike the From: address, these probably do have
something to do with the spammer. Again, don’t
complain to the actual addresses — aim your
complaints to the 1SPs that provide them service.

There aren’t any Web sites mentioned in the spam
in figure 3. Thereis an email address,

or der disknow@fr eeisp.com, so we can add
freeisp.com to the complaint list. (The real
“freeisp.com” is a provider of free email accounts.)

Step 3: Find an email address on those
machines to send your complaint to.

Most 1SPs have an email address for complaints
about abuses of their services. It's
abuse@domain.name often enough that you can
just send your complaint there: abuse@bigisp.net,
abuse@spanishisp.com, and so on. If a message to
an abuse address bounces, try re-sending it to the
postmaster account.

If you want to be sure your message will be seen by
areal person, you can look the machine's IP
address up in Network Solution’s Whois database.
DShield.org’s Whois lookup page is a good way to
query Whois: http://www.dshield.or g/ipinfo.php
The data returned includes the name and contact
info for atechnical contact person for the machine.

(DShield is a new Web-based Internet intrusion
detection complaint service; it collects and analyzes
the intrusion attempt logs kept by persond firewalls
such as ZoneAlarm. Personal firewalls were
introduced in the April/May/June 2000 issue of the
A3C Connection.)
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What about spam
on Usenet?

Spam is more
broadly defined in
Usenet newsgroups.
Anything that is not
related to the
group’s subject can
be considered
offensive. Many
groups also have
specific restrictions
on ads and binaries.

Complaints about
Usenet abuse should
be directed to the
news administrator
at the poster’s site.
At UIC, that's:
newsmaster @uic.edu

Step 4. Compose and send your complaint.

Sending a note saying, “You spammed me, stop it
now.” won't help anyone.

Unless you include a copy of the spam message and
all its headers, the |SPs won't be able to do
anything about your complaint.

v’ Always include a copy of the spam message
with your complaint, including full headers.

v’ Always forward the spam to the address you're
complaining to rather than replying or creating a
new message. Forwarding keeps the message’s
original headers intact.

v Make sure your complaint is before the body of
the spam. ISPs get spam just like the rest of us;
if your message looks like spam, they'll
probably just delete it.

v’ Send only one complaint per ISP per spam
message. Sending multiple messages won't get
your complaint acted on any faster.

Speaking as someone who has to reply to spam
complaints now and then, please remember that
you're complaining to the | SPs that the spammer is
using, not to the spammer. So please keep your
complaint short and polite.

For the originating
Figure 1: A Eudora Filter ISP and the | SPs of
To create afilter in Eudora, select Tools>Filters, addresses or W\eb
then click New. The default mailbox for the Transfer sites in the body of
Toaction is In; click on the mailbox bar to select the spam:
another one. Make sure you put this generd filter after . o .
all your specific filters. Say, for example, one that “This unsolicited email
moves all your incoming email from LISTSERV or message appears to be
LSOFT listsinto its own folder. from one of your users.
Please take appropriate
—Match actions to ensure it
W Incoming ™ Manual doesn’t happen again.”
Header: [To: =| | For ISPsused as
[doesn't contain | Ijudygs relays
“This unsolicited email
|and | message appears to
have been relayed by
Header [Co =l | one of your machines.
|doesn't contain _vJ |judygs quase take approp”ate
actionsto close this
s open relay.”
|'=5’ Transfer Ta ;l junk |
|© skip Rest N
1 1
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Don’t expect to receive personalized replies.

Whileit is true that most | SPs are happy to receive
complaints about people who are misusing their
services, it is aso true the people who take care of
these complaints at most | SPs are overworked. And
they're likely to have already received other
complaints regarding the spam you' re complaining
about. So you'll probably receive an automated
“Thank you for your information” reply. I think that's
just fine. I"d rather they spend their time closing the
spammers down than sending replies to me.

Spam Complaint Web Pages

Does this all seem like too much trouble? These
Web sites offer free spam complaint services.

Spam Cop: http://spamcop.net/
Network Abuse Clearinghouse:
http://www.abuse.net/

Keep in mind that “free” doesn’'t mean anonymous.
These services could be abused, so they’re careful
not to respond to false complaints.

Or you can forward your spam email to the U.S.
Federa Trade Commission’s spam collection
address: uce@ftc.org
(http://www.ftc.gov/og/1998/9806/email.htm).

Tricks to Minimize Email Spam

There's nothing you can do to prevent spam. But if
you get alot of it or if it really bothers you, there are
some things you can do to protect yourself from it.

Never Reply To Spam

The people who worry about spam say you can
reduce the amount of spam you receive by never
responding to spam email, either directly or by
visiting the spammer’s Web site. That just identifies
you as areal person who read their message.

Thisincludes replying to spammers’ offers to remove
you from their mailing lists. The only exception isif
the email in question isn't redlly “unsolicited” — say,
if it's from a company that you’ ve done online
business with. Then unsubscribing isworth atry. You
may even get an apology.

Use Email Filters

Even if you can't avoid spam altogether, you can
keep it from clogging up your inbox. Most spam

email isn’t addressed directly to you. So, you can set
up an email filter to move all messages that aren’t
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What about the
other SPAM?
Hormel Foods, the
makers of SPAM,
the luncheon meat,
is good-natured
about the use of
their trademarked
name for unsolicited
email. They only
ask that we use
spamin all lower
case for the email
and save SPAM in
all upper case for
their product. Visit
their Web site,
http:/iwww.spam.com,
which celebrates
“The one in good
taste.” There's even
a SPAM fan club
and, of course,
SPAM “stuff”,
including SPAM
boxer shorts if
you're so inclined.

addressed directly to you into a separate mailbox.
The Eudorafilter in figure 1 does just that.

You don't want to delete these messages without
looking at them; there will be some that you want
to read or save, such as messages from LISTSERV
or LSOFT lists and also email sent to you as a Bec:
— blind carbon copy.

Use Usenet Wisely

In the old days, | used to post to Usenet newsgroups
that are open to the entire world. In the old days, |
used to get alot of spam email, too. The spam-to-
real-emalil ratio for my judygs@uic.edu email
address has dropped steadily since | stopped using

it to participate in public newsgroups. Thisis purely
circumstantial evidence, but alot of other people
have noted similar circumstances.

Unfortunately never posting to Usenet groups won't
prevent you from getting spam, and I’ ve got
circumstantial evidence to demonstrate that too.
Another of my accounts, adabyron@uic.edu, is
only used for demonstration purposes and has never
posted to any Usenet newsgroup — | don't think
I"ve sent more than ten email messages from it in
all. It gets about as many spam messages as
judygs@uic.edu does.

Switch to Email-Based Discussion Lists

| was able to quit using Usenet because | found
closed email-based discussion groups —
LISTSERV or LSOFT lists for which no one except
for the group’s owners can request subscriber lists
— that cover the technical topics that | commonly
want to discuss. | was lucky; it's entirely possible
that you won't be able to do this.

Use a “Throw-away” Address on Usenet

Open an email account on one of the free email
services available on the Internet, such as Y ahoo! or
Hotmail. Use that address when you post to public
Usenet newsgroups or when a Web page requires
you to enter an email address, and decide that you'll
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live with whatever spam that account accumulates.
Free accounts generally have a small inbox and/or
automatic deletion of older (unread) email — both
are good antispam measures.

The bad news is that some Web pages refuse to
accept thiskind of email address.

Fake your own From: address:

Take a hint from the spammers — avoid getting
spam by using a somewhat faked version of your
own email address when posting to a public forum
or newsgroup. Include some text that makes your
address indecipherable to an automated program but
easy enough for a person to figure out. For
example, | could use this From: address:
judygsTAKEOUT @uicREM OVE.edu
This would make my netid and domain name
useless to the average harvester, but people should
know what to do with it. (Read “Help I've been
Spammed! What do | do?" by Greg Byshenk before
you do this, though; he explains how to do it right:
http:/Aww.byshenk.net/ive been.spammed.html)

If your newsreader or your ISP won’t et you do
this, you could use a Web-based Usenet service such
as Deja.com instead (http://ww.de a.com/usenet).
They don't have any problems with your using an
atered From: address.

About UIC Usenet Groups

The UIC-only Usenet groups — ones whose names
start with uic., including all the ones used by UIC
classes — are restricted to distribution on the UIC
campus. The restriction is made based on IP
address, like most other UIC-only Internet services.
This means that only a harvester program that was
run on the UIC campus could be used to capture
email addresses from posts to these groups. That's
not impossible, but it does make it alittle harder to
harvest UIC addresses.

Comments are welcome; please send them
to Judith Grobe Sachs, judygs@uic.edu

Reading Emalil Headers

Tech Tips

Email headers are the lines at the top of an email
message that are used by servers on the Internet as
they deliver the message. Your email program
normally shows you only the standard To:, From:,

WWW Experts

Subject:, and Date: headers, but there are more.
The most important header when you want to
complain about spam is Received:, which tells you
the route the message took when it was sent to you.
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Figure 2: Headers of a Legit Email Message
These are the slightly altered, complete headers of a normal email message.

Return-Path: <judygs@myisp.com>
O Received: from daedalus.cc.uic.edu (daedal us.cc.uic.edu [128.248.155.70])
by email1.cc.uic.edu (8.9.3/8.9.3) with ESMTP id SAA16958
for <judygs@email1.cc.uic.edu>; Wed, 6 Dec 2000 18:35:07 -0600 (CST)
@ Received: from postbox.myisp.com (smtp.myisp.com [111.208.131.20])
by daedalus.cc.uic.edu (8.9.3/8.9.3) with ESMTP id SAA(01839
for <judygs@uic.edu>; Wed, 6 Dec 2000 18:38:48 -0600 (CST)
© Received: from myisp.com (local212.myisp.com [111.208.141.212])
by postbox.myisp.com (8.10.2/8.10.2) with ESMTP id B70X 2E26999
for <judygs@uic.edu>; Wed, 6 Dec 2000 18:33:02 -0600 (CST)
O Message-1D: <3A2EDAFA F4735272@myisp.com>
O Date: Wed, 06 Dec 2000 18:34:03 -0600
@ From: Judith Grobe Sachs <judygs@myisp.com>
X-Mailer: Mozilla4.61 [en] (Win95; 1)
X-Accept-Language: en
MIME-Version: 1.0
@ To: Judith Grobe Sachs <judygs@uic.edu>
Subject: Hi there!
References: <5.0.0.25.2.20001128152553.00f90cd0@mailserv.uic.edu>
Content-Type: text/plain; charset=us-ascii
Content-Transfer-Encoding: 7hit
X-UID: 7

Figure 3: A Typical Spam Email Message

These are the complete headers, altered to protect both the innocent and the
guilty, and part of the body of an actual spam message.

O Received: from spanishisp.com (qrd32565.grd.es [111.125.139.235])
by postbox.myisp.com (8.10.2/8.10.2) with SMTP id eA03121
for <judygs@myisp.com>; Sun, 19 Nov 2000 18:14:14 -0600 (CST)
Received: (gmail 20320 invoked from network); 19 Nov 2000 08:50:54 -0000
@ Received: from dialup35.atl.bigisp.net
(HELO dialup35.atl .bigisp.net??111.122.81.677) (111.122.81.67)
by grd32565.qrd.es with SMTP; 19 Nov 2000 08:50:54 -0000
© Received: from
by dialup35.atl.bigisp.net with ESMPT; Sun, 19 Nov 2000 03:39:01 -0400
O Message-1D: <00000ee45f 1f$00003dcf$00004947@>
O Date: Sun, 19 Nov 2000 03:38:48 -0400
@ From: flyfish64@englishisp.com
@ To: <Undisclosed.Recipients>
Subject: 60 million email addresses on CD + 17 million More
MIME-Version: 1.0
Content-Type: text/html; charset="is0-8859-1"
X-Priority: 3
X-MSMail-Priority: Normal

60 million email addresses on CD and a bonus of 17 million more, for $389 Never
offered before and never offered again.

All orders placed up to that time will be shipped on the 5:30Pm Last of day pickup.

Ad $10 for overnight Delivery! Call 888 555 1212 or email your order to
mailto:orderdisknow@freeisp.com

PS Then this sale and outrageous price ends forever Monday at 4pm No
exceptions.
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You can instruct most email programs to display the
full headers of any message that you receive. While
viewing the message,

In Eudora: Click the Blah Blah Blah button.

In Netscape: Select: View>Headers>All

In Outlook: Select: View->pOptions

In Pine: Type H. (Requires the enable-full-header -
cmd feature.)

In Webmail: WebMail doesn’t have provisions to
display extended headers. Use Eudoraif you
can. If not, if your email account is on tigger or
icarus, you can login and use pine.

Figures 2 and 3 are the full headers of a normal
email message and an actual, and typical, spam
message. Comparing the two will give you an idea
of how email travels and how spam differs from
normal email messages. Except for the UIC-related
items, the domain names, |P addresses, and email
addresses in the headers have been altered.

The domain names and | P addresses in Received:
headers are those of the actual machine that
performed the service. These headers can be faked,
but it's harder to do than faking From: addresses.

Received: Headers

The Received: headers of any email message will
tell you where the message originated and what
route it took to get to you. That’s what you need to
know to complain about spam.

You read Received: headersin reverse order. The
sequence from the last Recelved: header in the
message's headers — that is, the one furthest down
in the headers — to the first Received: header
should take you from the email server where the
message originated, to alocal incoming email
server, and finaly, to your inbox.

The Last Received: Header:

The last Received: header(s) in any message should
identify (1) the first email server that handled the
message and (2) its intended recipient.

For example, consider line © in figure 2:

Received: from myisp.com (local212.myisp.com ...)
by postbox.myisp.com (...) with ESMTPid ...
for <judygs@uic.edu>; Wed, 6 Dec 2000 ...

Compare this with the equivalent line in the spam
message, line © in figure 3.

Received: from
by dialup35.atl.bigisp.net with ESMPT; Sun, ..
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The spam'’s header gives us very little information
about where it originated and doesn’t say anything
about whom it’sto go to. Thisis common in spam.
The “dialup35.atl.bigisp.net” domain name is
atered: inred lifeit wasadidin line that | believe
isin Atlanta, Georgia. It belongs to arealy big ISP.

The lack of a“from” addressin the spam’s
Received: header most likely means that the
spammer used SMTP services on their own machine
to send the message; most spam-generating software
comes with basic sending mail services built-in.

Line @ isthe next Received: header in both
messages. In figure 2, line @ shows a simple trip
from myisp.com to daedalus.cc.uic.edu, a mail
server at UIC that handles incoming email. Line @
in the spam message is more interesting:

Received: from dialup35.atl.bigisp.net

(HELO dialup35.atl.bigisp.net??7111.122.81.677) ...
by qrd32565.qrd.es with SMTP; 19 Nov 2000 ...

The 111.122.81.67 and qrd32565.qrd are altered too,
but the .esisn’t; .esis the upper level domain for
sitesin Spain. This says that our spammer choose to
send the message first to a machine in Spain.

The top Received: header, line @ in both
messages, describes the final delivery of the
message. The spam’s top Received: header has
additional information about the route it took:

Received: from spanishisp.com (qrd32565.qrd.es ...)
by postbox.myisp.com (...) with SMTP id eA03121
for <judygs@myisp.com>; Sun, 19 Nov 2000 ...

More altered domain names and | P addresses, but a
quick ndookup (see below) on the real names

nslookup: Matching Host Names and IP Addresses

The nslookup command allows you to match a machine’s Internet domain name
(such email1.cc.uic.edu) with its IP address (such as 128.248.150.51) or vice versa.
There’s andookup command tigger and icarus. It'sin WS Ping Toolsin the
Windows Network Services Kit (or you can open a DOS window and enter the

nslookup command directly). There are also various nslookup Web sites,
including InfoBear's http://www.infobear .com/ndookup.shtml.

Most nsookup utilities determine the search type from the format of the input. |

logged into tigger to run these ndookup commands:

>nsl ookup email 1. cc.uic.edu
Server: uic-dns2. uic.edu
Address: 128.248.7.50

Nane: emai | 1.cc.uic.edu
Address: 128.248. 150. 51

(Wondering what the email 1.cc.uic.edu here and in figure 2 is? My email account
ison mailserv, which, a thistime, isa cluster of two Unix machines. My account
happens to be on the second of the two machines, email1. The first is email0.)

>nsl ookup 128. 248. 150. 51
Server: uic-dns2.uic.edu
Address: 128.248.7.50

Nane: emai | 1.cc.uic.edu
Address: 128.248.150.51
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confirmed that the domain names qrd32565.qrd.es
and spanishisp.com are associated with the same IP
address, so they point to the same machine. In rea
life, that machine belongs to company in Spain.

So, the Received: headers, lines ©, @, and @ in
each message, give us the route that the message
took. The spam message’s route is quite suspect:
from a dialup, perhapsin Atlanta, through a
machine in Spain, and then to Chicago. And that's
for a message whose stated sender isin the United
Kingdom. (See the From: header below.)

About the Top Received: Header

Whether spam or legitimate email, the first
Received: headersin any email message will
awaysinvolve aloca machine. Messages
delivered to uic.edu addresses will have afirst
Received: header like the onein figure 2, line @:

Recelved: from daedalus.cc.uic.edu (...)
by emaill.cc.uic.edu (...) with ESMTPid ...
for <judygs@emaill.cc.uic.edu>; Wed, ...

The mention of a local machine in the top
Received: header is correct and does not mean
that that machine (daedalus, eeyore, or winnie,
for example) is participating in sending spam. It's
just delivering your incoming email to your
account like it's supposed to do.

Other Headers

From: headers in spam messages are usually fake,
and generally aren’t much use. The spam’s From:
header, line @, makes it seem that the message
came from afly fishing site in the United Kingdom.
It is probably faked.

The Message-1 D: header should tell you where the
message originated; its value is an id number,
followed by “@", followed by a machine name
(consider line @ in figure 2). The spam’s M essage-
I D: header leaves out the machine name:

Message-I D: <00000eed5f 1f$00003dcf$00004947@>
Not much help here, either.

There's More Online

Space in the newsletter is limited; for more about
email headers, check out this article online:
http://lwww.accc.uic.edu/newd etter /adn29/

Comments are welcome; please send them
to Judith Grobe Sachs, judygs@uic.edu
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This article was
contributed by
Joy Hyzny, Office
of Disability
Services

She would be happy
to help you with any
access problems or
questions you might
have. Contact her at
312-413-0886 or by
email at
jhyznyl@uic.edu.
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Designing Accessible Web Pages

Tech Tips

Calling al Web designers! Surely you want to give
your audience the same thing that you want as a
Web user: effective and efficient navigation to the
most useful information on your pages. And the way
you design your site will have a direct impact on
how accessible it is to those who surf your pages.

At UIC, your target audience probably includes
faculty, staff, and current and prospective students,
not to mention outside faculty, parents, and many
others. Y ou should keep in mind that such a diverse
audience will include people with disabilities;
people without fast Internet connections, big
monitors, or the latest technology; and people who
use mobile computing devices.

The Accessibility Goal

When designing a Web site, keep this goal in mind:
creating a Web site that allows for the effective and
efficient navigation of information on your pages by
everyone who surfs the site. Because many different
people will surf your pages, the way you design your
site has a direct impact on how accessible it will be
for them.

While reading this article, consider your current
Web site or a site you frequently surf. Is the site
accessible? If not, how would you make it
accessible? Read on to find out! And after you
make your site accessible, enter it in the university-
wide Web accessibility contest. (See “UIC Web
Accessibility Contest” on page 11.)

Creating Web Pages

Creating a Web site is quite easy. Hypertext Markup
Language (HTML) is used to create the page.

HTML isaset of tags, or codes, that describe how
the information is to be presented on the page.
Although some developers enter HTML codes
manually as they create a page, people who are less
familiar with HTML may use a“What You See Is
What You Get” (WY SIWY G) editor. On our
campus, Dreamweaver is frequently used for this
purpose. However, for the most part, it doesn't
matter what you use to create a Web site. It's the
way you design your Web site that is critical!

WWW Everyone

The Importance of Web Design

Access to All

How many Web pages do you surf on a daily basis
that are difficult to read and confusing? Chances are
you have come across many pages that have not
been designed with accessibility in mind, allowing
visitors to be able to locate information and content
in an effective and efficient manner.

Accessible sites are especially vital for people with
disabilities. As Tim Berners-Lee, World Wide Web
Consortium (W3C) director and the inventor of the
World Wide Web, says, “The power of the Web is
inits universality. Access by everyone regardless of
disability is an essential aspect.” (From the W3C's
Web Accessihility Initiative (WAI) page:
http://iwww.w3c.or g/lWALI/)

Legislation

There are several |egislative mandates or factors
specific to Web accessibility and/or institutional
responsibilities in providing access to al students.
These include: Sections 504 and 508 of the
Rehabilitation Act of 1973, the Americans with
Disabilities Act, and Section 255 of the
Telecommunications Act. California, New York, and
Texas are among the states that have published
access policy documentation. Refer to
http:/imww.w3.or g/ WAI/Refer ences/Policy#US
for more information.

Web accessibility is also being emphasized and
implemented in higher education. The University of
Wisconsin-Madison has just adopted a Web access
policy; you can obtain specific information at:
http:/lwww.wisc.edu/wiscinfo/policy/wwwap.html

Web Accessibility at UIC — An
Example

In August, Walter Edelberg, an associate professor in
the Department of Philosophy, created atext version
of the department’s Web page after being notified that
the home page on their Site was inaccessible. At that
time, most of the links on the Department of
Philosophy home page were clickable areas within an
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Users without
disabilities also
benefit: the
accessible site
loads faster and it's
easier for everyone
to use.

Accessibility

Standards:

The Architectural and
Transportation Barriers
Compliance Board
(Access Board) has
recently published
“accessibility standards
for electronic and
information technology
covered by section 508
of the Rehabilitation
Act Amendments of
1998.” To find out
more about
requirements and
timelines, visit:
http://www.access-
boar d.gov/sec508/508
standards.htm

image map, leaving all the information about courses
and similar offerings completely inaccessible to
students using screen readers.

Walter made several improvements to the design
and style of the department’s Web pagesin order to
improve access. He cited a number of vital reasons
for achieving Web accessibility, including the
following: “(1) Making your department’s Web site
accessible isin your department’s interest: you will
reach awider audience. (2) It is unfair to deploy
education materials (including information on your
department) that are inaccessible to some students,
when those materials could be made accessible to
all without too much trouble. (3) It conforms to
federal laws. (4) Users without disabilities also
benefit: the accessible site loads faster and it's
easier for everyone to use.”

| asked Walter about the greatest benefit of knowing
about Web accessibility. He replied, “Before
learning about ‘Web accessibility,’ | didn’t know
that software screen readers and Braille displays are
available to help make Web content available to
people with disabilities. Now | know that if we do
our part, our department Web site can be used with
these devices. Knowing about Web accessibility has
also helped me to design course Web sites that are
cleaner and easier for everyone to navigate.”

Y ou're probably wondering how long it will take to
make your Web site accessible. It took Walter only
one afternoon to create an accessible version of the
department’ s 63-page site. The approach that Walter
used was to “ deploy two versions of our Web site:
the original one (with graphics), and an accessible
version (text only). A link near the top of the
graphics version takes users to the text-only site. To
make the text-only pages, we simply copied the
entire site to a new folder, then removed images
and background graphics from the copied files. We
added a site map to the accessible version to make
it easier for all users to navigate.”

At first, it took Walter some time to become
accustomed to making changes on both versions
when updating the site. By now, though, Walter
says that it's becoming routine. So it does not
necessarily need to take along time to make an
inaccessible site accessible. Furthermore, keeping
Web accessibility guidelines in mind as you work
will help you to design a site from the beginning
that will provide you ultimate access from the start.
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The Department of Philosophy’s text-only pages are
being used. The department uses the Webalizer
program on tigger
(http:/Awww.uic.edu/depts/accc/webpublwebalize
r.html) to track the number of hits and users.

Walter stated, “In November 2000, we had a total

of 1413 hits on our six main section home pages.

Of these, 13 percent were on the accessible versions
of the pages. For the undergraduate section, that
figure jumps to 28 percent.”

For additional information about designing
acessible Web pages, see:
http://lwww.uic.edu/depts/accc/webpub

Making Your Web Page Accessible

The following recommendations will provide you
with ideas to make your Web site accessible:

Web Access Essentials:

v’ Add descriptive ALT text tagsto all graphic
images. ALT text tags allow a person using a
screen reader to obtain a better understanding of
the Web page's content. In most browsers, the
ALT text also appears in small window when the
mouse cursor is placed over the image.

v’ Use appropriate descriptions for hypertext links.
Avoid using “click here” without providing
information about why the link is important.
Descriptive link text is aso good for the Web
search engines that categorize pages by the text
with which they are linked.

v’ Provide a site map to alleviate confusion among
your various Web pages.

v’ Provide column headings, table headers, and a
table summary if you use tables. Keep in mind
that tables, if not designed correctly, can be very
difficult to understand for people using screen
readers.

v’ Stay away from frames — they do not have the
necessary level of access.

v’ Use cascading style sheets (CSS) to ensure that
Web pages that are similar in structure are also
similar in appearance. Web pages that have a
consistent layout are easier for everyone to
navigate efficiently. The key hereis to ensure that
the page' s style offers good organi zation.

v’ Create Web pages using “relative” font sizes.
Thiswill alow the user to access the site with
their own browser settings.
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Unfortunately,
however, no
available technology
can intuitively
interpret the various
aspects of Web page
design.

v’ Choose text colors that provide enough contrast
from the background color and vice versa, so
that the text is easy to read.

v’ If theinitial page in your Web siteis not as
accommodating as it could be, create a text-only
version of it. The link for the text-only version
of the page should be located near the top of the
Web page. Ideally, however, your initial page
should be accessible enough that a text-only
version won't be necessary.

Additional Tips:

v’ Provide essential material on your initial (home)
page.

v’ Avoid placing too much information on any one
page.

v’ Set your pages up so that the user will not need
to perform multiple mouse clicks to get to basic
material and will not need to navigate from one
end of the screen to the other repeatedly.

v’ Avoid using abbreviations, or be sure to type the
information out, followed by the abbreviation.

v" Use correct HTML code and validate the code.

v' If you decide to use additional media (audio,
video, graphic, etc.), make the information it
contains accessible in an alternative form.

W3C Web Accessibility Initiative

To assist you with the process of designing
accessible sites, the World Wide Web Consortium
(W3C) has created the Web Access Initiative (WAI)
guidelines. The latest Web Content Accessibility
Guidelines (Version 1.0) were released in May 1999
and can be found at:
http:/mww.w3.org/TR/WCAG10/#Guidelines

The W3C WAI guidelines take into consideration
the needs of your visitors and the manner in which
they access the Web. Good Web design will
incorporate access to Web pages for those using
different agents or platforms — i.e., computer,
phone, etc. — and operating within different
environments — loud, visually restrictive, etc.
(http:/Amww.w3.0rg/TR/WAI-WEBCONTENT))

W3C Quick Tips

When you're first starting, the W3C WAI guidelines
might be a hit overwhelming. In that case, you
might prefer the W3C Web Access Initiative' s ten
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“Quick Tips” listing fundamental considerations for
accessible Web pages (http://mww.w3.or g/ WAI/Re
ferences/QuickTips#QuickTips). You can aso
contact Joy Hyzny from the Office of Disability
Services at 312-413-0886 for further details.

Navigating a Web Page From the
Perspective of a Surfer With a
Disability

People with disabilities frequently use assistive
technology products. These products are designed
to provide a method for performing a specific
activity. The assistive technology products designed
specifically for computer access include: screen
magnifiers and readers for people with visual
disabilities; alternative input devices, ergonomic
mouse options, and voice recognition for people
with physical disabilities; and touch screens for
people with cognitive disabilities. Thisis by no
means an al-inclusive list.

These products provide people with disabilities an
avenue to access the computer. Unfortunately,
however, no available technology can intuitively
interpret the various aspects of Web page design.

Visual Disabilities — Screen Magnifiers

For people with limited vision, there are software
programs that will magnify information on the
computer screen. ZoomText is one such program. It
provides options that allow the user to customize
the amount of magnification he or she needs.

Overall Structure of the Page

A magjor factor in Web design that hinders access
when using screen magnifiers is the organization of
the page. When people with visual disabilities surf
your page using a screen magnifier, they will only
have a partial view of what each page actually
looks like. They will thus be at a disadvantage if
your pages require an overall view to understand
them. Headings, lists, consistent structure, and, in
particular, the use of the same cascading style
sheets for each page’s layout and style will help
organize your pages.

A repetitively structured site will provide people
using a screen magnifier — or people with small
monitors — with the necessary tools to know what
to expect when linking to the next page.
Consistency is a good thing!
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ALT tags are vital if
there is a link within
a graphic. Without
them, a user using a
screen reader will
have no idea that the
link exists.

Visual Disabilities — Screen Readers

By using appropriate hardware (a speech synthesizer)

and a software program (a screen reader), people with
visual disabilities can listen to information on the Web
page asit isread aloud. Window-Eyes and JAWS are

two commonly used screen readers.

Graphicsand the ALT Tag

One of the major factors that contribute to poor Web
access when using screen readers relates to graphic
images. Screen readers read basic text. Therefore,
graphics that do not contain an ALT text tag will not
beread. The ALT tag provides the screen reader
with textual information about the graphic image.
Thisisvital if thereis alink within the graphic. If
no ALT tagis present, the user will have no idea
that the link exists, denying them access to essential
information.

It is extremely easy to add an ALT tag in either
Dreamweaver or basic HTML. If you have a
graphic image that displays “LogIn”, for example,
an appropriate HTML code you can use to include it
might be something like:

<I MG SCR="1 ogi nphot 0. j pg” ALT="Logl n">
In Dreamweaver, you can indicate the ALT text by
clicking on the image and typing the text in the Alt
field in the Propertiesinspector box. (Select
View->Properties to open the Properties box.)

Reading Tables

Another major consideration when designing Web
pages for use with screen readers is to understand
that a screen reader reads information line-by-line,
from left to right, just like we do when we read
standard text out of a book. It is easy to get
confused when a screen reader reads Web pages
with rows and columns.

Whenever you use a table in a Web page, consider
designing it with the rows as columns (that is, order
the information from left to right instead of top to
bottom) to ensure greater access and understanding
of the table when it is read by screen readers.
Providing headers and a summary of your tableis
another way to make your table more accessible.

Frames and Drop Down Menus

Frames and drop down menus are also problematic
for people using screen readers. Although the WA
provides some ideas for using frames, the
accessibility is still low whenever you them. And
remember that frames cannot be bookmarked.
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Therefore, Web page designers should avoid frames
at al cost.

Additional Accessibility Features

There are accessibility features built in to Windows
95, 98, and 2000, as well asin various Web
browsers. Internet Explorer (IE), for example, has
numerous settings that allow for greater access.

For more information about Internet Explorer’s
accessibility features, select Help from the Internet
Explorer menu bar, then Index, then Disabilities,
Access for. For information on Windows
accessibility features, click Start, then Help. Click
on the book icon beside How To to expand the How
To menu, and browse the Set Up Windows
Accessibility Features menu.

Testing Your Page

There are several specific ways to check your page
for accessibility. A couple of common programs
allow the Web page designer to type in their Web
address (URL) and perform a check based on the
W3C WAI guidelines. Bobby,

http:/lwww.cast.or g/bobby, is most commonly
used for this. UsableNet's LIFT,
http://lwww.usablenet.com, is another program that
can be especialy helpful in identifying and
resolving accessibility issues.

These programs will not do everything for you; they
overlook many accessibility features. For example,
they cannot examine the page’s overall organization.

How Accessible Is My Web Page?

As part of your Web page evaluation process, it isa
good ideato view it in atext-only browser such as
Lynx or by turning off the graphics in Internet
Explorer or Netscape. It is also helpful to view your
page using severa versions of both Internet
Explorer and Netscape to ensure maximum access.

For example, here's how to check your page using
Internet Explorer.

First, open your page in Internet Explorer and
examine it to make sure you know where al the
graphics are. Then, when you are ready to turn
pictures off, select Tools>Internet Options

- Advanced, scroll down to Multimedia, and
uncheck Show Pictures. Click the OK button and
Refresh your display. (Click the Refresh icon —
two arrows on a sheet of paper — or select View
- Refresh.) The page will now appear without




The A3C CONNECTION

Copies of this
newsletter are
available in an
alternative
format.

Call Joy Hyzny
(312-413-0886) or
Judith Grobe Sachs
(312-996-3758) to
obtainit.

pictures.

There are additional Multimedia features that you
can select to get a better idea of how your page will
be read by a screen reader. Go back to Tools>
Internet Options—=>Advanced>Multimedia.
Make sure that the following boxes are not
checked: Play Animation, Play Videos, Show
Image Download Placeholders, Smart Image
Dithering, in addition to Show Pictures Now
check your page again.

You can aso try using the Tab key to navigate your
pages and obtain a better sense of how screen
readers navigate. Using tabs is the only way to
move around in atext-only browser. If you' ve never
used one, log into your icarus or tigger account and
try it. Enter: lynx your.page.uic.edu

You should find it instructional .

Follow these steps with several of your Web pages.

Resources

W3C' s Web Accessibility Initiative:
http:/mww.w3.or g/ WAI

UIC Officeof Disability Services: http://www.uic.
edu/depts/counselctr/disability/disvebpg.htm

A-Prompt: http://aprompt.snow.utoronto.ca

Bobby HTML validation program:
http://lwww.cast.or g/bobby

Do-It World Wide Access: Accessible Web Design
(1997, 2000). University of Washington:
http:/www.washington.edu/doit
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Making Educational Software Accessible: Design
Guidelines Including Math and Science
Solitions: http://Aww.wgbh.org/ncam
(A software program to synchronize text with
AV or pictures, etc. WGBH in Boston and
funded by Trace Center.)

The National Center for Accessible Media:
http:/lwww.wgbh.or g/wgbh/pages/ncam/
webaccess/index.html

Trace Research and Development Center:
http:/lwww.trace.wisc.edu

UsableNet's LIFT: http://www.usablenet.com

Powell, T. A. 2000. Web Design: The Complete
Reference. Osborne-McGraw-Hill: Berkeley.

Paciello, Michael G 2000. WEB Accessibility for
People with Disabilities. CMP Books: Lawrence,
Kansas.

For More Information

If you are interested in more information, in a
potential Web accessibility class, in help with
reviewing your page using assistive technology
products, or in the availability and use of assistive
technology at UIC, please contact Joy Hyzny in the
Office of Disability Services at 312-413-0886.

Also look for additional articles on this subject in
future issues of the A3C Connection.

Comments are welcome; please send them
to Joy Hyzny, jhyznyl@uic.edu

UIC Web Accessibility Contest

Calling al departments and units... This challenge
goes out to you! Revisit your official UIC Web
pages with an eye toward accessibility, redesign
them, and enter your newly accessible Web pages
in the Office of Disability Services Web
Accessibility Contest.

Entries will be reviewed for effective Web design
techniques that optimize access and provide an
informative and engaging site for al visitors. Y our
ability to design an interesting and accessible Web
page is only limited by your creativity. Refer to
the items above for accessibility tips.

A panel of judges with experience in disability,
Web design, and accessible Web issues will review
the entries for ultimate accessibility. The judges
will consider the various accessibility and media
properties that distinguish a site as exceptional.

To enter the contest, send an email message to Joy
Hyzny at jhyznyl@uic.edu. Include:

® your name,

* the name of your department or unit, and

* the Web address (URL) of the page you're
submitting.

All entries must be received on or before 4:00
p.m. on Friday, April 6, 2001. Winners will be
notified by phone and email on Friday, April 23,
2001.

Computer-related prizes will be awarded to the
faculty or staff sponsor submitting the winning
entry for their particular department or unit.

The winners will be listed in the April/May/June
issue of the A3C Connection.
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